
 
 
 
 
 
 
 
 
 

 

 

 

  

Software Guide 
 

 
andor.com  © Andor Technology 2014 

Database Viewer 
 version 2.0.4 rev 27 November 2014 

 

  

 



 
 
  

 

2 

Database Viewer 

Revised 27 Nov 2014 

Table of Contents 
Table of Contents .......................................................................................................................................................... 2 

SECTION 1: THE DATABASE VIEWER ............................................................................................................................. 4 

1.1 Introduction ...................................................................................................................................................... 4 

1.2 Organization of Datasets – Security, Tables and Tabs ....................................................................................... 5 

1.3 Terminology ...................................................................................................................................................... 5 

SECTION 2: VIEWING DATASETS ................................................................................................................................... 6 

2.1 Opening Datasets .............................................................................................................................................. 6 

2.1.1   Database Window: Data Tab ............................................................................................................................. 7 

2.1.2   Database Window: Data Audit Tab .................................................................................................................... 8 

2.1.3    Database Window:Session Record Tab ...................................................................................................... 9 

2.1.4 Database Window: System Audit Tab ................................................................................................................ 10 

2.1.5 Database Window: Decode Tab ......................................................................................................................... 11 

2.1.6 Database Window: Summary Tab ...................................................................................................................... 11 

2.1.7 Database Window: META Tab ........................................................................................................................... 12 

2.2 DBV Menu: File ...................................................................................................................................................... 13 

2.2.1 File: Open Database ........................................................................................................................................... 13 

2.2.2 File: Close Database ........................................................................................................................................... 13 

2.2.3 File: Make Standalone CD .................................................................................................................................. 13 

2.2.4 File: Export ......................................................................................................................................................... 14 

2.2.5 File: Print Table .................................................................................................................................................. 15 

2.2.6 File: Merge Databases ........................................................................................................................................ 15 

2.2.7 File: Exit .............................................................................................................................................................. 16 

2.2.8 File: Recent File List ............................................................................................................................................ 17 

2.3 DBV Tab: Graphs ................................................................................................................................................... 18 

2.3.1 Graphs: Histogram ............................................................................................................................................. 18 

2.3.2 Graphs: 3D Histogram ........................................................................................................................................ 20 

2.3.3 Graphs: Bar Chart ............................................................................................................................................... 22 

2.3.4 Graphs: Response Curve .................................................................................................................................... 23 

2.3.5 Chart Menu ........................................................................................................................................................ 26 

2.4 DBV Tab: Gallery ................................................................................................................................................... 27 

2.4.1 Gallery ................................................................................................................................................................ 27 

2.4.2 Gallery Options .................................................................................................................................................. 29 

2.5 DBV Tab: Data ....................................................................................................................................................... 32 



 
 
  

 

3 

Database Viewer 

Revised 27 Nov 2014 

2.5.1 Data: Create Summary Table ............................................................................................................................. 32 

2.5.2 Data: Decode Database(s) .................................................................................................................................. 35 

2.5.3 Data: View Outliers ............................................................................................................................................ 40 

2.5.4 File Menu for View Outliers ............................................................................................................................... 41 

2.5.5 Exclude Data ....................................................................................................................................................... 42 

2.5.4 Show Database ................................................................................................................................................... 43 

2.6 DBV Tab: Windows ................................................................................................................................................ 44 

2.6.1 Windows: Tile ..................................................................................................................................................... 44 

2.6.2 Windows: Cascade ............................................................................................................................................. 44 

2.7 DBV Menu: Help .................................................................................................................................................... 44 

2.7.1 Help: Help ........................................................................................................................................................... 45 

2.7.2 Help: About ........................................................................................................................................................ 45 

SECTION 3: INSTALLING THE SOFTWARE .................................................................................................................... 46 

SECTION 4: 4 DEFINITIONS AND INFORMATION ON DECODING DATASETS AND CREATING SUMMARY TABLES ..... 47 

References .................................................................................................................................................................. 48 

 

 

Contact Information: www.andor.com/contact_us/support_request 

 

This version updated for Database Viewer 2.0.4, revised 27 Nov 2014 

 

 

 

 

 

 

 

 

 

 

http://www.andor.com/contact_us/support_request


 
 
  

 

4 

Database Viewer 

Revised 27 Nov 2014 

 

SECTION 1: THE DATABASE VIEWER 
 

 

1.1 Introduction 
 
The Database Viewer (DBV) is supplied with certain products, including Komet® and Komet®GLP. This 
software saves data in two formats: 

• Tab-delimited format, which can be read by standard spreadsheet programs such as Microsoft 
Excel. Excel macros are provided to ease the analysis and presentation of this data. 

• A Database format, which includes images and data. The Database Viewer is the means to view, 
analyse and present data from these files. For GLP operation Study and Scoring audit trails can 
also be viewed. 

The DBV is supplied via download from  my.andor.com or on a separate installation CD and is installed as 
described in Appendix 1. The DBV is opened from the Kinetic Program Group and provides the following 
functions: 

• Load and View Datasets containing images and data from a group of specimens. 

• Datasets usually contain all the data from an exposure group. 

• View audit trails on data, scoring sessions, study information and QC. 

• Present data for comparison in graphical forms including Histograms and Response 

Charts. 

• Decode Slide or specimen IDs into Dose or Exposure groups to support blind scoring. 

• Present Data Summaries compatible with international guidelines for statistical analysis. 

• Create Image Galleries to present the comets from complete or a subset of the 

Dataset. 

• Create a stand-alone CD, which includes the selected Dataset(s), DBV program and all necessary 
support files to run DBV on any Windows 7 PC. 

Thus, DBV provides a powerful and easy means to review, present and prepare your data for statistical 
analysis. Further, it provides a means to distribute Study data in the form of stand- alone CDs containing 
Datasets and all the necessary tools for review and presentation to colleagues, Quality Assurance 
Personnel, sponsors and reviewers. 

Database Viewer can be distributed freely, without restriction by authorized license holders of our software. 

We hope you find the product both easy and powerful to use and thank you for choosing our products. 

http://my.andor.com/
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1.2 Organization of Datasets – Security, Tables and Tabs 
Datasets are databases named with either an mdb or kdb extension. Mdb files are readable in Microsoft 
Access. You should be aware that opening a file in Access before scoring is completed will damage its 
electronic signature and render the file unusable for GLP work. We recommend you use ONLY the DBV for 
working with these files. 

The Dataset contents are organized into several tables, and each table is presented on a different tab in 
DBV, as described in detail in section 2.1. GLP and non-GLP Datasets are both produced by Komet products 
depending on the mode of operation specified. The GLP Datasets will contain additional tabs for Audit 
Trails - information gathered during the scoring process, when the Datasets are recorded. 

Datasets can be decoded and analysed to generate additional data such as Statistical Summary data. When 
you operate in this way DBV will create a copy of the original Dataset, to maintain the integrity of the RAW 
data. In the copied Dataset it will add new tables, visible as extra tabs in DBV. These will contain additional 
information about the Decode and/or Data Summary actions and results. 

  
1.3 Terminology 
 
In the following descriptions of the DBV Software, we use some terms to explain functions in the software 
which may have specific meaning. We use these terms to exemplify, not to 

limit the application of the product. These terms include: 

• Dose and Dose Groups which can equally refer to Exposure and Exposure Groups. 

• Database and Dataset are used to refer to a collection of data organized in tables readable by the 
DBV. 
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SECTION 2: VIEWING DATASETS 
DBV enables datasets (GLP and Research formats) to be viewed for analysis and auditing purposes. 

 

2.1 Opening Datasets 
Click the Open Database button on the File tab: 

 

 
 
Or from the File Menu select File then select Open Database (Section 2.2.1), this will display a file open 
dialogue box where the user can navigate to the appropriate folder and select a Dataset to open. 

 

 
 

Figure 2.1.1 Opening a Database 
 
The user will then be prompted to enter the password for the Dataset. 

 

 
 

Figure 2.1.2 Enter Password 
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The Dataset is then presented as shown in Figure 2.1.3. The Database Window has four tabs in the GLP 
version. These are Data, Data Audit, Session Record and System Audit. In the 

Non-GLP version, all of these tabs will not be present. Additional tabs for Decode and Summary are added 
to the Decoded Dataset once they are created through the appropriate functions (Section 2.5.2). 

2.1.1   Database Window: Data Tab 

 
 
Figure 2.1.3 The Database Window Data Tab 
 

The upper pane of the Data Tab displays the data obtained from your experiment. Each row of data 
displays the ID of the image from which data was obtained, the Slide ID and all the values for each analysis 
parameter. 

When you click on a row of data, the image from which the data was obtained is displayed in the lower 
pane along with a calibrated ruler to show comet lengths. 
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2.1.2   Database Window: Data Audit Tab 

 

Figure 2.1.4 The Database Window Data Audit Tab 
 
The Data Audit Tab (Figure 2.1.4) provides a record of operator actions during the scoring process. The 
Cell ID, Data ID, Action, and reasons are listed for any changes made throughout the study. 
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2.1.3    Database Window:Session Record Tab 

 

Figure 2.1.5 The Database Window Session Record 

The Session Record Tab (Figure 2.1.5) provides information on all of the scoring sessions. The user name 
corresponding to each scoring session, the session action, the reason for suspending the scoring session, 
start and end dates, times, Slide IDs and Scoring Protocol are presented. 
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2.1.4 Database Window: System Audit Tab 

 

Figure 2.1.6 The Database Window System Audit Tab 

The system Audit Tab provides information for all tracked changes made to the Datasets and Protocols 
(Figure 2.1.6). It also provides information relevant to the QC Audit Trail and the QC Audit Details. 
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2.1.5 Database Window: Decode Tab 

 

Figure 2.1.7 The Database Window Decode Tab 

The Decode Tab is added to the Dataset window once a decode is performed as shown in Figure 2.1.7. 
However, this tab only appears in the new dataset created by the decode operation. The new dataset name 
is derived from the original as follows: 

Original Name       Decoded Name  

Duodenum_RAW.kdb → Duodenum_RAW_DECODED.kdb  

This tab provides all information relating to the decoded dataset. For information on how to decode a 
database (dataset) see Section 2.5.2.  

2.1.6 Database Window: Summary Tab 

 

Figure 2.1.8 The Database Window Summary Tab 
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The Summary Tab is added to the Database window after a summary is performed. This Tab is only visible 
in the new dataset created through the decode operation as described in the previous section. Additional 
summaries can be performed and are subsequently added to the Database window as shown in Figure 
2.1.8. For more information on how to create a Summary Table see Section 2.5.1. 

2.1.7 Database Window: META Tab  
This has no experiment data but contains Komet application information that is useful for technical support. 
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2.2 DBV Menu: File 
When the DBV application is running, the relevant menus will be active. Their exact content depends on 
which window has focus. When a Dataset Window has focus or no Dataset is open, the menu items shown 
in Figure 2.2.1 are available. When other types of window such as the Gallery and Chart windows have 
focus the menu items on view will change (Sections 2.4.2 and 2.8). 

 

Figure 2.2.1 The File Menu 
 

2.2.1 File: Open Database 
Selecting Open Database displays a standard Window’s Load File dialogue, from which you should select the Dataset 
to open. You can open multiple Datasets and manage or compare their contents. The Datasets will be presented as 
explained in Section 2.1.  

2.2.2 File: Close Database  
Selecting Close Database closes the currently selected Dataset.  

2.2.3 File: Make Standalone CD  
Selecting Make Standalone CD from the file menu will open a dialogue box allowing the user to select the 
location to copy the files (Figure 2.2.2). Once a location is selected, the database and DBV files are copied 
to the selected location (i.e. CD) that can be opened on any Windows 7 computer.  
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Note: If a CRW drive is selected, a formatted CD is required. CRW formatting instructions are 
dependent on the software being used. 

 

Figure 2.2.2 Select Drive for Standalone CD 

2.2.4 File: Export  
The Export feature enables the user to export Database File (*.kdb) to MS Access (*.mdb) file (Figure 2.2.3). Support 
for other database platforms may be added in future. 

 

Figure 2.2.3 File Export 
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2.2.5 File: Print Table  
Selecting Print Table from the file menu allows the user to print tables from the currently selected Dataset. All 
Tabs in the selected Dataset will be listed as shown in Figure 2.2.4. Select the Tab you wish to print and a 
standard print dialogue box will open allowing for printer selection and properties. 

 

Figure 2.2.4 Print Table 

2.2.6 File: Merge Databases 
Selecting Merge Databases from the file menu enables user to merge several open Datasets into a new Dataset. 
Select the open Datasets to merge by clicking on the dataset(s) or by using the Select All or Deselect All 
buttons. Selected Datasets will have their checkboxes labelled with a tick. You can change the order of the 
Datasets by using the Move Up and Move Down buttons. 

 

Figure 2.2.5 Select Datasets to Merge 

Press OK to continue. 
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Figure 2.2.6 Merge Databases Message 

You will then be prompted as seen in Figure 2.2.6. Selecting No will exit the process. Selecting Yes will merge 
the databases and open a Save As dialogue box (Figure 2.2.7) allowing you to name the new file. 

 

Figure 2.2.7 Save As 

2.2.7 File: Exit  
Selecting Exit will close all open Datasets and exit the DBV application. 
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2.2.8 File: Recent File List  
This feature shows the 5 most recently opened Datasets at the bottom of the menu as shown in Figure 
2.2.8. Click on a file to reopen the Dataset. 

 

Figure 2.2.8 Recent File List 
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2.3 DBV Tab: Graphs 

 

Figure 2.3.1 Graphs Tab 

From the Graphs tab, you can select a method to present the data in a graphical form.  

Note - When a Chart Window has focus, different menus are available (see Section 2.3.5).  

2.3.1 Graphs: Histogram 

 

 

Figure 2.3.2 Histogram Dose Group Selection 

When a Dataset is open and selected, clicking on Histogram from the Graphs menu displays a 
dialogue box (Figure 2.3.2) which allows selection of the Specimens or Dose groups for which you 
wish to see a histogram plot.  

The Select All and Deselect All buttons can also be used. When you press OK a histogram window 
will open for each selected dose.  

The Histogram dialogue box shown in Figure 2.3.3 has many controls to format the histogram 
presentation to your needs. 
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From the dropdown list shown in Figure 2.3.3, select the parameter for which you want to display a 
histogram. All analysis parameters can be selected for review in the histogram.  

Range Minimum and Maximum Settings  

The Min and Max values are displayed on the left of the dialogue box (Figure 2.3.3) these are the 
minimum and maximum values calculated from all the cells scored in that specimen or group. 

 

Figure 2.3.3 Histogram 

The text boxes are used to enter the minimum and maximum values for the bins to display on the 
Histogram. You can restore the computed Min and Max values from the current sample at any time by 
pressing the Use Min/Max button.  

Set Defaults  

You can also set up Default Minimum and Maximum values for the histogram bins. To do this, enter 
the desired values into the Minimum and Maximum text boxes and press the Set Default button. You 
can then select these values at any time by pressing the Use Defaults button. This allows you to fix 
settings for standardized reporting of data with different ranges i.e. most real data.  

Number of Bins  

Enter the Number of bins - the x-axis will be split into a number of divisions equal to the value 
specified here. (Note that there will be two additional bins, one containing all valuesbelow the minimum 
bin and the other with data above the maximum. These register any data that lies outside of the 
specified minimum and maximum values).  
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Show as Percentage  

When selected, the data will be displayed as a percentage of the number of cells rather than displaying 
the actual frequency of data. This presentation is useful for standardizing the presentation of data from 
specimens in which a different number of cells or fields was scored.  

2.3.2 Graphs: 3D Histogram 

 

Selecting 3D Histogram from the Graphs tab opens a dialogue box which is used to create a 3D 
presentation. This allows you to open multiple Datasets, which is useful for data comparison. The first 
dialogue box will appear as shown in Figure 2.3.4. Click in the checkboxes to select the datasets to 
include in the histogram or use the Select All and Deselect All buttons.  

You can change the order that the datasets will be displayed in the histogram using the Move Up and 
Move Down buttons.  

Press OK to continue. 

 

Figure 2.3.4 Select Dataset(s) for 3D Histogram 

A dialogue box will then open for each selected Dataset and list the available doses in that dataset. 
You can change the order of the doses as above or use the Select All and Deselect All buttons. 
Selected Datasets will have their checkboxes labelled with a tick. 
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Select the doses to include in the histogram (Figure 2.3.5) and press OK to continue. 

 

Figure 2.3.5 3D Histogram Dose Group Selection 

After selecting the doses from the final dataset, the histogram will be displayed (Figure 2.3.6). 

 

Figure 2.3.6 3D Histogram 

From the dropdown list, select the parameter for which you want to display a histogram. The Min and 
Max values are displayed on the left of the dialogue - these are the minimum and maximum values 
calculated from all the comet cells scored in the selected doses. 
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Set Defaults  

You can also set up Default Minimum and Maximum values for the histogram bins. To do this, enter 
the desired values into the Minimum and Maximum text boxes and press the Set Default button. You 
can then select these values at any time by pressing the Use Defaults button. This allows you to fix 
settings for standardized reporting of data with different ranges i.e. most real data.  

Number of Bins  

Enter the Number of bins - the x-axis will be split into a number of divisions equal to the value 
specified here. (Note that there will be two additional bins, one containing all values below the 
minimum bin and the other with data above the maximum. These register any data that lies outside of 
the specified minimum and maximum values).  

Show as Percentage  

When selected, the data will be displayed as a percentage of the number of cells rather than displaying 
the actual frequency of data. This presentation is useful for standardizing the presentation of data from 
specimens in which a different number of cells or fields was scored. 

3D View Angles  

You can change the 3D view angle by holding down the left mouse button over the 3D Histogram. 
Move the mouse to rotate the graph to the desired position.  

2.3.3 Graphs: Bar Chart 

 

When a Dataset is open and selected, clicking on Bar Chart from the Graphs tab displays a dialogue 
box in which all the doses in the Dataset are listed (Figure 2.3.7). Select the doses for which you want 
to display a Bar Chart (selected doses have their checkboxes labelled with a tick). The Select All and 
Deselect All buttons can also be used. 

 

Figure 2.3.7 Bar Chart Dose Group Selection 
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When you press OK a Bar Chart will open for each selected dose as shown in Figure 2.3.8.  

From the dropdown list in Figure 2.3.8, select the parameter for which you want to display a bar chart. 
Values are displayed for each cell scored in that dose. If Use record name on x axis is selected, each 
set of data is labelled with its source image. If it is not selected, they are labelled according to their 
identifier (a number determined by the order in which they are scored during the experiment). 

 

Figure 2.3.8 Bar Chart 

2.3.4 Graphs: Response Curve 

 

 

Figure 2.3.9 Select Dataset(s) for Dose Response Curve 
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Response Curves are used to compare data from different doses in the Experiment. If you select 
Response Curve from the Graphs tab, a dialogue box will list all opened Datasets (Figure 2.3.9). Click 
in the checkboxes to select the Datasets to include in the histogram or use the Select All or Deselect 
All buttons. You can change the order that the Datasets will be displayed in the curve by using the 
Move Up and Move Down buttons.  

Press OK to continue. 

 

Figure 2.3.10 Dose Selection for Response Curve 

A dialogue box will then open for each selected Dataset and list the available doses in that Dataset 
(Figure 2.3.10.). You can change the plotting order as above. Select the doses to include in the 
Response Curve or use the Select All or Deselect All buttons. Press OK to continue. 

 

Figure 2.3.11 Select Statistics 

Select the statistics you wish to plot, selected statistics have their checkboxes labelled with a tick 
(Figure 2.3.11). A Response Curve will be plotted for each selected statistic. Options atthe bottom of 
the dialogue box allow the inclusion of error bars on the plots. When you have made your selection 
press OK to continue. 
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Figure 2.3.12 Dose Response Curve 

From the dropdown list, select the parameter for which you want to display a Response Curve (Figure 
2.3.12).  

The statistic for each selected dose is represented by a point on the curve - the points are colour 
coordinated and a key below the curve tells you which colour corresponds to which dose. 
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2.3.5 Chart Menu  
Different menus are available when the Histogram, 3D Histogram, Bar Chart or  

Response Curve dialogue boxes are selected (Figure 2.3.13). 

 

Figure 2.3.13 The Chart Menu Bar 

Options 

Defines the style of the selected chart. This includes the format, colour and position of titles and other 
text, and the background colour for the selected chart. The style will be remembered for the current 
session of the Database Viewer. 

Series Colour 

Allows you to select the colour in which to display the data on the selected chart. 

Print 

Opens the Printer Setup dialogue, from where you can print the selected chart. 

Show Database 

Places the Database Window on top of all other Windows. 
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2.4 DBV Tab: Gallery 

 

Figure 2.4.1 The Gallery Tab 

2.4.1 Gallery 

 

Selecting Gallery opens a dialogue box which displays messages depending on whether the dataset 
has been decoded or not. If the data set has not been decoded a list of all slide names will appear 
(Figure 2.4.2) and if the dataset has been decoded the list of dose groups will appear (Figure 2.4.3). 
Select the slides or dose groups to view by selecting them individually or by using the Select All and 
Deselect All buttons. Selected slides or groups are labelled with a tick. 
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Figure 2.4.2 Gallery Slide Selection 

 

Figure 2.4.3 Gallery Dose Group Selection 

Press OK to continue. If Datasets are large, the gallery may take a few minutes to open. 

The Image Gallery shows an image of every cell scored in the selected slides or dose group(s) in the 
upper pane. Calipers (vertical red lines) show the start and end of the comet Head and Tail regions as 
analysed by Komet®. If ‘Head Ellipse’ is selected in Comet Options, then an ellipse will be shown 
delineating the Head region. Deleted Cells are also recorded in the Gallery, but to indicate their 
rejection from data analysis they are shown with a single diagonal Red Line indicating their status as 
shown in Figure 2.3.4. If Image Numbers are selected, Red numbers are shown on the individual 
images, indicating the data position in the current Dataset. 
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Figure 2.4.4 The Gallery Window 

The lower pane shows the ID (a number determined by the order in which it was scored during the 
experiment), the Session in which the cell was scored, the Slide Number, Slide Replicate, and all the 
values for each analysis parameter. The lower pane will also show if the selected cell is a Deleted 
Record and if so the number referring to the Reason it was deleted as shown in Figure 2.4.4.  

2.4.2 Gallery Options  
When the Gallery dialogue box is open, the available menus will change. 

 

Figure 2.4.5 The Gallery Menu Options 

Printing the Gallery  

Selecting Print from the options menu opens the Image Print Setup dialogue box. This allows the 
Gallery to be printed on a user-defined number of pages by setting up the comet image density. The 
Number of Pages will change as the Number of Columns and Rows per page is adjusted. 
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Figure 2.4.6 Image Print Setup 

Clicking on Setup… opens the printer setup dialog 

 

Once the printer has been setup, click OK to confirm the settings.  

When the Image Print Setup dialog is visible, press Print to accept your selection and being printing. 
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If the assigned number of rows and columns per page is too large, an error message will be received 
and allow the user to re-define the parameters (Figure 2.4.7). 

 

Figure 2.4.7Selectedparameterstoo large error message 

Image Numbers  

This can be toggled on and off by a mouse click. When on, the image number is displayed in the top 
left of each image (Figure 2.4.4). They are numbered in the order that they were opened or acquired 
during the scoring session.  

Show Database  

The Window containing the Dataset will be displayed on top of all other windows. 
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2.5 DBV Tab: Data 

 

Figure 2.5.1 The Data Tab 

Note: See Appendix 2 for definitions and more information on Decoding Datasets and Creating 
Summary Tables.  

2.5.1 Data: Create Summary Table 

 

Note: A Dataset should be decoded before selecting Create Summary Table (See Decode 
Databases(s) Section 2.5.2).  

When a Decoded Dataset is open and selected, clicking on Summary Table from the Data Menu 
displays a dialogue box in which all the doses in the decoded database are listed (Figure 2.5.2). Select 
the doses you want to display in a Summary Table (selected doses have their checkboxes labelled 
with a tick). The Select All and Deselect All buttons can be used for selecting groups. You can 
change the order that the doses will be displayed in the Summary Table by using the Move Up and 
Move Down buttons. 

 

Figure 2.5.2 Dose Selection for Summary Table 

Press OK to continue.  

A Summary Table of DATA dialogue box will open that allows you to select the Required Parameters 
to measure based on what is required for data presentation (Figure 2.5.3). 
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Select the desired Statistics for both the Individual and Dose/Group and the number of decimal places 
for data presentation. 

 

Figure 2.5.3 Summary Table Window 

Once all parameters are selected, press the Update button. This will update the bottom window as 
shown in Figure 2.5.4. 

 

Figure 2.5.4 Updated Summary Table Window 
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Once the table is updated any changes can be made and viewed by pressing the Update button. Once 
you are satisfied with the selected parameters, the Summary Table can be saved as an excel 
spreadsheet by clicking on save from the top left hand menu shown in Figure 2.5.5. 

 

Figure 2.5.5 Save Menu 

A Save Summary Table dialogue box will appear (Figure 2.5.6) to allow you to name and save as an 
excel spreadsheet (*.xld). 

 

Figure 2.5.6 Summary Table Save As Option 

The Summary Table is also added to the Database Window as a Summary Table Tab. Additional 
summaries can be created and a tab will be added to the Dataset for each Summary Table. The 
Summary Table Tabs in the Dataset will be numbered in the order they were created as shown in 
Figure 2.5.7. 

 

Figure 2.5.7 Database Window Summary Tab 
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2.5.2 Data: Decode Database(s) 

 

When a Dataset is open and selected, clicking on Decode Database(s) from the Data Menu displays 
a dialogue box asking to re-enter the password for the Dataset. 

 

Figure 2.5.8 Re-enter Password 

A warning message will be received if the database has already been decoded. You can choose to 
overwrite existing decode as seen in Figure 2.5.9. Selecting No will send you back to the original 
Dataset. 

 

Figure 2.5.9 Decode Database Error Message 

Once the password is entered the Dataset will be copied and ‘_DECODED’ will added to the file name.  

Edit Dose IDs  

The ID Decoder Dialogue Box is then opened allowing you to Edit Dose IDs and Add Dose IDs. The 
Clear All and Delete Last buttons can be used to during the selection process 
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Figure 2.5.10 ID Decoder 

If Edit Dose IDs is needed, it must be performed before the Add Dose ID function. If not, an error 
message will be received stating that this action will invalidate any Dose IDs already assigned.  

The Edit Slide IDs dialogue box list the Slide Names on the left and any changes made on the right 
(Figure 2.5.11). To change a slide id, highlight the desired slide and press the Change button. Press 
Cancel at any time to exit Edit Slide IDs. 

 

Figure 2.5.11 Edit Slide ID 

The Update IDs dialogue box will appear and allow any necessary changes to be made. Once 
changes are made press OK (Figure 2.5.12). 
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Figure 2.5.12 Update Slide IDs 

Once changes are complete the Edit Slide IDs Dialogue box will re-appear and show any changes 
made (Figure 2.5.11). 

Once complete, press the OK (2.5.10) will once again appear.  

Add Dose IDs 

The ID Decoder Dialogue Box (Figure Now you are ready to Add Dose IDs. 

After pressing the Add Dose IDs button the Create New Dose ID dialogue box will appear and allow 
you to select the Dose ID (Figure 2.5.13). The three options are to type in the name and units, Positive 
Control or Negative Control. The Drop down list for units will remember the last entry and continue to 
give that entry to you as an option. If no entries are present in the drop down box, you can simply type 
in the desired units. Press OK. 

 

Figure 2.5.13 Create New Dose ID 

The Assign IDs dialogue box will appear and allow you to select the slides to add to dose group. Once 
all slides are selected, press OK. 
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Figure 2.5.14 Assign IDs  

Continue adding dose groups and assigning slides using the Add Dose IDs button on the ID Decoder 
Window (Figure 2.5.15). The Dose ID and slides assigned to that dose will appear in the window as 
the doses are added. Remember, the Clear All and Delete Last buttons can be used whenever 
needed. 

 

Figure 2.5.15 ID Decoder with Dose IDs Assigned 

After all doses are added, press OK. All slides must be assigned to a dose group before proceeding. 
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Figure 2.5.16 Database Window Decode Tab 

A Tab will then appear in the Database Window containing all the information entered as seen in 
Figure 2.5.16. 
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2.5.3 Data: View Outliers 

 

When a database is open and selected, clicking View Outliers from the Data Menu displays a Select 
Required Parameter dialogue box (Figure 2.5.17). 

 

Figure 2.5.17 Select Required Parameters for Outliers 

Select a parameter from the dropdown list to view and press OK. If the Dataset is decoded, a dialogue 
box will appear allowing you to select the dose groups to be included as shown in Figure 2.5.18. If the 
Dataset is not decoded, a list of slide ids will be listed in the dialogue box. Selected dose groups or 
slide ids will have their checkboxes labelled with a tick. Select All and Deselect All buttons can be 
used. 

 

Figure 2.5.18 Select Dose Groups for View Outliers 

Press OK.  

Any outliers in that selected parameter will be shown in the View Outlier Window as shown in Figure 
2.5.19. 
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Figure 2.5.19 View Outlier Window 

The upper pane of the Outliers Window shows the ID, Session, any Notes, the Name of the image, 
and all analysis parameters. When you click on a row of data, the image from which the data was 
obtained is displayed in the lower pane of the window along with a calibrated ruler to show comet 
lengths.  

2.5.4 File Menu for View Outliers  
When the View Outlier Window is open, the file options change (Figure 2.5.20). 

 

Figure 2.5.20 View Outlier Menu Bar 
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The View Outliers option automatically shows all outliers within three standard deviations of the mean. 
Under the Exclusion Criterion drop down menu, you have the option of selecting outliers within two 
standard deviations of the mean (2 SD) or three standard deviations of the mean (3 SD). If you chose 
two standard deviations from the mean, the View Outlier Window will automatically update. You can 
also change which parameter to view by selecting a different parameter from the list (Figure 2.5.20).  

2.5.5 Exclude Data 

 

Figure 2.5.21 View Outlier Menu Bar 

If you want to Exclude Outlier Data, select Exclude Data from the file menu. An Exclude Data 
Dialogue box will appear as seen in Figure 2.5.21. 

 

Figure 2.5.22 Exclude Data 

Selecting No will return you to the view outlier window. Selecting Yes will exclude the data and the 
Data Tab, Data Audit Tab and Session Record Tab will show the excluded data as seen in Figures 
2.5.22, 2.5.23, and 2.5.24. 

 

Figure 2.5.23 Excluded Data in Data Tab 
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Figure 2.5.24 Excluded Data in Data Audit Tab 

 

Figure 2.5.25 Excluded Data in Session Record Tab 

2.5.6 Show Database 

 

Figure 2.5.26 View Outlier Menu Bar 

Show Database puts the Database Window on top of all the other windows. 
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2.6 DBV Tab: Windows 

 

Figure 2.6.1 The Windows Tab 

2.6.1 Windows: Tile 

 

This determines how the open Datasets in the Database Viewer will be displayed. Selecting Tile will 
allow the user to see all open datasets in one window.  

2.6.2 Windows: Cascade 

 

This determines how the open Datasets in the Database Viewer will be displayed. Selecting Cascade 
will show the selected Dataset in front of all other Datasets. The Cascade option is also the default. 

2.7 DBV Menu: Help 

 

Figure 2.7.1 The Help Menu 
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2.7.1 Help: Help 

 

Selecting Help opens the Software Guide for the Database Viewer. Note that Adobe Reader or similar 
software is required to view the Software Guide. 

2.7.2 Help: About 

 

Selecting About displays information about the version number and release date of the DBV, gives 
copyright credits and contact information. 

 

Figure 2.7.3 The About Dialogue Box 
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SECTION 3: INSTALLING THE SOFTWARE 
 

Download: my.andor.com  

Contact: www.andor.com/contact_us/support_request 

 

To install the Database Viewer from the Installation CD, simply insert the CD into the drive and follow 
instructions. Or if the CD does not auto play, then select the Start.exe program from the root folder of 
the CD.  

If running a standalone CD made by Komet®, Komet GLP or DBV, then just insert the CD and DBV 
will start and load the default Dataset. If the CD does not Auto run, then double click on the Autorun.ini 
file in the CD root folder. 

  

http://www.andor.com/contact_us/support_request
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SECTION 4: 4 DEFINITIONS AND INFORMATION 
ON DECODING DATASETS AND CREATING 
SUMMARY TABLES 
Data Summary Creation as a Preliminary to Statistical Analysis in The GLP Database Viewer - 
Definitions  
 

According to a recent paper on monitoring genotoxic effects in humans presented (Albertini RJ et al), 
the statistical analysis of data from genetic toxicology assays follows two distinct approaches, 
depending on whether the data is continuous or binary. The former data is produced by assays such 
as comet and UDS, where features of interest are respectively %DNA damage and number or area of 
developed silver grains, driven by DNA synthesis. The latter is represented by assays such as 
micronucleus (MN) or Chromosome aberration, where we are concerned with presence or absence of 
micronuclei or aberrations in various classes. The latter data generally follows a binomial distribution, 
while the former is commonly normal or normal after transformation. The techniques utilized in data 
analysis make no assumptions about the underlying form of the distribution, simply the nature of the 
data.  

In this summary we will consider only the continuous forms in relation to the data summary functions 
within the Database Viewer.  

• First of all the Study Director chooses the study design depending on the scientific questions 
being asked. This will establish the dataset created during scoring and will include the number 
of samples, number of replicates (slides) per sample. The set of sample replicates will generally 
be considered the unit of exposure. This is determined in Komet protocol set up. Scoring will 
commonly be carried out blind to minimize the potential for scorer bias, but as scoring proceeds 
Komet prompts the scorer to introduce replicate samples sequentially and pools the data for a 
sample from the set of replicates. For the purposes of a concise process definition, we will refer 
to the ith unit of exposure ui(e).  

• Next the dataset will be decoded in the Database Viewer. Using the Decoder tool, samples are 
grouped into dose or exposure groups or other groupings key to the nature of data analysis. 
Examples include comparisons of datasets from replicate experiments or the study of 
underlying variability in positive or negative control data from a series of datasets. For the 
purposes of a concise process definition, we will call the ith dose or exposure group gi(e).  

• The next step is to specify the parameters to be used for the data summaries and these include 
selections from mean, standard deviation, standard error, dispersion and coefficient of variation. 
Alternatively, we can choose a non-parametric description in the form of percentile, which 
includes the median (50 percentile). These parameters are then computed row-wise and 
presented for each unit of exposure and column-wise for each dose or exposure group. The 
computations for groups is based on computing mean of means or mean of percentiles and the 
standard deviation etc. is computed on the variability of means or medians.  
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• This is presented in mathematical notation below.  

U(e) Mean percentile Std Dev Sem Dispersion CV n 
U1(e) µ1 P1 Ã1 Á1 H1 cv1 e.g.100 
U2(e) µ2 P2 Ã2 Á2 H2 Cv2 N2 
U3(e) µ3 P3 Ã3 Á3 H3 Cv3 N3 
U4(e) µ4 P4 Ã4 Á4 H4 Cv4 N4 
U5(e) µ5 P5 Ã5 Á5 H5 Cv5 N5 
Group, G1 µ1(µ) µ1(P) 
Ã(µ) or Ã(P) Ã1(µ) Ã1(P) 
Á(µ) or Á(P) Á1(µ) Á1(P) 
H(µ) or H(P) H1(µ) H1(P) 
CV(µ) or CV1(µ) CV1(P) 
CV(P) 
Number, n e.g. 5 

 
U6e) µ6 P6 Ã6 Á6 H6 Cv6 N6 
U7e) µ7 P7 Ã7 Á7 H7 Cv7 N7 
U8(e) µ8 P8 Ã8 Á8 H8 Cv8 N8 
U9(e) µ9 P9 Ã9 Á9 H9 Cv9 N9 
U10(e) µ10 P10 Ã10 Á10 H10 Cv10 N10 
Group, G2 µ2(µ) µ2(P) 
Ã(µ) or Ã(P) Ã2(µ) Ã2(P) 
Á(µ) or Á(P) Á2(µ) Á2(P) 
H(µ) or H(P) H2(µ) H2(P) 
CV(µ) or CV2(µ) CV2(P) 
CV(P) 
Number, n e.g. 5 

 

Table 1. Data Summary Table definition for the GLP Database Viewer  
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